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Agent Ransack 

Background: 
When conducting an investigation, it is sometimes helpful to see if the provider has appeared in any 
of the HICAPS Management Reports. The following tool is used by HCF to search across all the 
HICAPS files for the particular provider number. 

Procedure: 

Step 1- Installation  
Speak with your IT team about what tools are available. Some IT departments may require approval 
before you install a new piece of software on your system. Should they approve the installation, it 
can be downloaded from www.mythicsoft.com/agentransack free of charge. Run the installation file 
and follow the prompts. 

We encourage all users to undertake due diligence before installing any software including, but not 
limited to, Agent Ransack. HCF accepts no liability whatsoever for any loss or damage arising from 
the use or misuse of any software, proprietary or otherwise, listed here within. 

Step 2- Setting the directory to be search 
You will need to tell the program which folder you want to search in. It is a good idea to have all you 
HICAPS reports put into one folder. 

1. Click on the  icon marked ‘1’ below 

 

2. A browse window will now appear- navigate to the folder that contains your HICAPS reports 

 

1 

http://www.mythicsoft.com/agentransack�
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3. Locate the folder and select it so that it is highlighted and click ‘OK’ 

 

Step 3- Setting the time period of files to be search 
To help speed up the search, you may want to restrict your search to a certain time frame. In the 
following example we have limited the search to files created after 1 January 2008. 

1. Click the ‘After’ icon  marked as ‘1’ below 

2. Click on the calendar icon  marked ‘2’ below. 

 

3. The calendar window will now appear 

 

4. Click the ‘Fixed Date’ option and then use the calendar to navigate to the date you wish to 
start the search. 
 

5. Click ‘OK 
 

6. The start date will now appear in the blue bar 
 

2 1 



Unlocking the Intelligence  Luke Givney- HCF 

~ 12 ~ 

 

Step 3- Limiting the search to relevant HICAPS Reports 
HICAPS produce numerous files each day including a file containing all claim transactions. To narrow 
the search to relevant files in the ‘File name’ field enter   *.nhi 

 

Step 4- Searching for a provider 
1. Enter the provider number into the ‘Containing text:’ field- marked as ‘1’ below  

 
2. Click ‘Start’- marked as ‘2’ below 

 

3. The program will provide you with a progress bar 

 

4. Once the process has finished, a full list of files containing that provider number will be listed 
on the left hand side of the screen 

2 1 
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5. Double click with your mouse on the file name to open the file. 
 

6. When the file is open, to find the provider hold in the ‘Cntrl’ key on your keyboard and 
whilst you have it held in, press the ‘F’ key. This will bring up find box as pictured below 

 

7. Type the provider number into the white rectangle and then click ‘Find Next’ 
 

8. This will take you to the exact spot within the document where that provider number exists   
 

9. Reports of particular interest are those starting with the letters: 
 

a. J 
b. K 
c. KM 
d. P 

 
Hint: You can expand the search by changing the provider number in the search field to the 
terminal number. This will find any reports that contain any of the providers that use that 
particular terminal 

 

  



 

 

 

 
Accessing HICAPS 
Online 
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Logging In 
1) Open an Internet Explorer page 
 

2) In the address bar type www.hicaps.com.au and then press enter on the keyboard 
 

3) You will now be directed to the HICAPS Homepage (pictured below). If you receive a 
connection error contact your IT team to enable access to this page. 

 
4) On the left hand side of the page will be a list of options. Click on ‘Login to HICAPS Accounts 

Online’ 
 

 

 
5) You will now be directed to the login page. Enter your use name and password. Speak with 

your HICAPS administrator if you do not already have access. 
 

6) Click ‘Log In’ 
 

4 
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Viewing provider information 
1) Log into HICAPS Online 
 

2) On the left hand side of the page will be a list of options. Roll your mouse cursor over the 
word ‘Providers’ 

 

3) A new option will now appear next to ‘Providers’ called ‘View provider detail’.  
 

 
 

4) Click on ‘View provider detail’. Note it may take a moment to direct you to the next page. 
Please be patient. 

 

5) Enter the providers Medicare provider number. This will be an 8 digit number starting with a 
numeric character and ending in an alpha character 

 

3 
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6) Click ‘Next’ 
 

7) You will now be directed to the provider summary screen. This will provide you with contact 
information and registration details. At the bottom of the page you will see the provider's 
‘status’.  

 

  

5 
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Searching for providers on the same 
terminal 

1. Log into HICAPS Online 
 

2. Locate the terminal number for the provider on the “Provider Details” screen- refer to 
“Viewing Provider Information” for how to access this screen. 

 

3. Write down for your reference the Terminal Number 
 

 
 

4. On the left hand side of the page will be a list of options. Roll your mouse cursor over the 
word ‘Providers’ then select “View Provider Search” 

 

 

3 
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5. You will now be directed to the provider search screen. Select ‘Terminal Number’ in the 
Search criteria drop down list. 

 

6. Type in the terminal number in the box  
 

7. Select the fields that you want to be displayed from the dropdown list in the “display 
results” section.  For example: 

a. Terminal Number 
b. Provider Number 
c. First Name 
d. Surname 
e. Spec code 1 
f. Spec code 2 

 

8. The results will now be displayed on screen (see below) for other providers using the same 
terminal. 

 

 

Hint:  If you click on the provider number of any of the records displayed in the results area, it will 
navigate you to that provider’s details screen.  

  

4 
5 

6 
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Viewing a transaction 
1) Log into HICAPS Online 
 

2) On the left hand side of the page will be a list of options. Roll your mouse cursor over the 
word ‘Funds’ 

 

3) A list of new options will now appear next to ‘Funds’.  
 

4) Click on ‘View Transactions’. Note it there is an option for ‘View Transaction Search’- do not 
use this option. 

 

5) You will now be directed to the screen pictured below. 
 

 

 

6) In the ‘Fund ID’ select your fund from the drop down list 
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7) Enter the date that the transaction was processed in both the ‘Start Date’ and ‘End Date’ 
fields. 
 

8) You can search by the following three criteria or any combination of them: 
 

a. Medicare provider number if you want to narrow the search to a particular provider 
number  
 

b. Membership number if you want to narrow the search to a particular policy 
 

c. ‘Terminal No.’ if you want to narrow the search to all claims via a particular terminal 
 
 

9)  Next to ‘Select Report Output Format’ ensure the View Onscreen radio button is selected. 
 

10) Click ‘Next’ 
 

11)  If any claims match the specified criteria you will be directed to the Transaction Search 
Results Screen (pictured below) 
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12)  If more than one claim matches the criteria you entered it will be shown as several lines. 
 

13)  Click on the ‘Txn Reference’ for the claim you want to view. 
 

14)  You will now be taken to another screen which will show the full details (pictured below) 
 

 

 

15)  The claims detail at the bottom of the page (highlighted in picture above as ‘1’) provides the 
following information: 

 

i. Patient ID- 1 = a, 2 = b, 3= c and so on 

ii. Item number- The last three digits are the item number 

iii. Body part ID- this will be the tooth ID for dental claims 

iv. Item date- This is the date of service in the format DD/MM- 

v. Requested amount- This is the amount charged 

vi. Benefit amount- The benefit HCF paid 

vii. Return code- This is the item response code. A full list of item response 
codes are attached as Appendix A 

 

16)  Marked as ‘2’ in the picture above is the Response Code. The response code will indicate if 
there has been an overall error with the claim such as membership not financial. A full list of 
transaction response codes are attached as Appendix B  

 

  

1 
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 Clustering of transactions 

Background 
During the investigation of a provider that has access to the HICAPS facility, it may be appropriate to 
check the time difference between transactions.  The HICAPS network records the exact time that 
the card was swiped and the transaction processed by the provider. 

Use to identify 
• Provider retains member cards and swipes through groups of claims 
• Provider adding items or patients to claims that were not provided (and could not possibly 

be provided in the time since last claim) 
• Identify backdating of claims to previous days (i.e. claiming for today and yesterday) 

Procedure 

Step 1- extracting data from HICAPS Online 
1. Navigate to the HICAPS website (www.hicaps.com.au) and login to “Accounts Online” 

2. Hover your mouse cursor over the ‘Funds’ tab on the top left hand side of the page. A box 
will now appear as shown below. 

 
 
 
 
 
 
 
 
 

 

3. In the box that has now appeared, select the “View Transaction Search” (see above) 

4. On the search screen: 
a. Change the ‘Report Output Format’ to “CSV Download”  

http://www.hicaps.com.au/�


Unlocking the Intelligence  Luke Givney- HCF 

~ 25 ~ 

b. Change the start and end dates to reflect the period you want the data extracted   
(Note: If the query is taking too long, please try a shorter time period) 

c. Put the provider number in the white box below the ‘Provider #’ field 
d. Ensure that the “Display Results” have the following options selected (preferably in 

this order): 
i. Sys Date 

ii. Provider # 
iii. Member # 
iv. Sys Time 

e. Click ‘search’ 
 

 
 

 

 

5. The ‘File Download’ box will appear (pictured below). Click on ‘open’ 
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E 
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Step 2- Changing file type from CSV to Excel workbook 
1. The file will now open in Excel. Currently it is in the format of ‘csv’, we need to change to an 

excel format. To do this: 
a. Click on the round circle in the top left hand corner 
b. Hover your mouse cursor over ‘Save As’ It is important you DO NOT
c. A box will now appear- click on “Excel Workbook” at the top of the list 

 click on it 

 

 
 

Step 3- Sorting transactions into chronological order 
1. Click on the ‘Data’ tab in the top menu of the excel workbook 
2. Click on the ‘Sort’ button 

 
 

3. To order the file correctly we need to sort by the date then by time. To do this: 
a. Click on the ‘Add Level’ button- this will add an extra line into the white box 
b. In the first drop down box select ‘SYS_Date’ 
c. In the second drop down box select ‘SYS_Time’ 
d. Click ‘OK’ 

A 
C 

B 

2 
1 
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Step 4- Resize the cells to fit the content 
1. Click on the corner between the letter ‘A’ and number ‘1’ as shown below- This will highlight 

all of the workbook 
2. Double click on the white line between ‘A’ and ‘B’ 

 

Step 5- Calculating the time difference 
1. In first empty cell (in this case E1) type in the title ‘Time Difference’ 
2. In the cell directly below (in this case E2) type the following formula 

=IF((A2=A1),D2-D1,"DIFF DAY") 
Note: This formula works on the assumption that the ‘SYS_Time’ is in column ‘D’. If it is not, 
substitute the letter ‘D’ in the formula for the column it is in. For example is SYS_Time was in column 
‘F’ the formula would be =F2-F1 

3. Press ‘enter’ 
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4. Click on the cell that is now showing “DIFF DAY” 
5. Double click on the black square in the bottom right hand corner of this cell (see below). This 

will now fill in the rest of the cells with the correct formula. 

 

Step 6- Adding a line break when the date changes 
1. Click in the first cell ‘SYS_Date’ 
2. Click on the ‘Subtotal’ button 
3. In the ‘Use Function:’ drop down menu, change from Sum to ‘COUNT’ 
4. In the ‘Add subtotal to:’ box, untick any boxes that are ticked 
5. Scroll up and tick the box next to “MEMBER_NUMBER” (this should be the only box ticked) 
6. Click ‘OK’ 

 

Step 7- Colour coding short time differences 
1. Click on the letter above the Time Difference cell (in this example it is the letter ‘E’). This will 

highlight the entire column 

 
2. Click on the Home tab in the menu bar 
3. Click on the Conditional Formatting button. A menu box will now be displayed below it 
4. In the menu box select ‘New Rule’ 
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5. A new box will now appear. In the “Select Rule Type” section click on Format only cells that 
contain 

6. In the “Edit the Rule Description” section: 
a. Enter 00:00:01 into the first blank cell 
b. Enter 00:10:00 into the second blank field 

Note: This will highlight field that have a time difference up to 10 minutes. 
You can change the number ‘10’ in step ‘B’ if you want to shorten or extend 
this time period. 

7. Click on the ‘Format…’ button 

 
 

8. A new box will now appear. Click on the “Fill” tab across the top 
9. Pick a colour that you would like the cell to be shaded if it is within the time frame you 

specified 
10. Click ‘OK’ 
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11. Click OK again 
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Monitoring membership cards 

Background 
Funds have uncovered in the past, practices that retain membership cards to swipe claims when the 
member is not present. This can be important for funds that do not allow backdating of claims. On 
family policies, one card can be left with the provider while the family utilises the other card for 
other legitimate transactions. This process will help identify which card is being used at what 
provider. 

Use to identify 
• Providers that are possibly retaining membership cards 
• Family memberships possibly leaving one card with a provider and using the other to claim 

all other claims 

Procedure 

Step 1- extracting data from HICAPS Online 
1. Navigate to the HICAPS website (www.hicaps.com.au) and login to “Accounts Online” 

2. Hover your mouse cursor over the ‘Funds’ tab on the top left hand side of the page. A box 
will now appear as shown below. 

 
 
 
 
 
 
 
 
 

 

3. In the box that has now appeared, select the “View Transaction Search” (see above) 

4. On the search screen: 

http://www.hicaps.com.au/�
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a. Change the ‘Report Output Format’ to “CSV Download”  
b. Change the start and end dates to reflect the period you want the data extracted   

(Note: If the query is taking too long, please try a shorter time period) 
c. Put the membership number in the white box below the ‘Member #’ field 
d. Ensure that the “Display Results” have the following options selected (preferably in 

this order): 
i. Sys Date 

ii. Sys Time 
iii. Member # 
iv. Provider # 
v. Card Data 

e. Click ‘search’ 
 

 
 

5. The ‘File Download’ box will appear (pictured below). Click on ‘save’ 

 

Important:  You must save this file rather than opening it. Excel will alter the card number if you 
do not follow the process below. 
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Step 2- Opening the file in Excel 
1. Open Excel 
2. Click on the ‘Data’ tab in the top menu of the excel workbook 
3. Click on the ‘From Text’ button 

 

4. Navigate to the location that you saved the file and select it 
5. Click ‘Import’ 

 

6. A new window will now appear. Ensure the button next to ‘Delimited’ is selected 
 

7. Click ‘Next >’ 
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8. On the new window in the ‘Delimiter’ section tick “Comma” [if any other boxes are ticked, 
untick them- there should only be one box ticked] 
 

9. Click ‘Next >’ 

 

10. Click with the mouse cursor in the ‘Card_Data’ field- the background will now change from 
white to black 
 

11. In the “Column data format” section, select ‘Text’ 
 

12. Click ‘Finish’ 

 

13. A new window will now appear- Click ‘OK’ 
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Step 3- Save the workbook 
1. Click Save and save the file in your desired location 

 

Step 4- Sorting transactions by Card Data 
1. Click on the words “CARD_DATA” [in the example this will be in cell E1] 
2. Click on the ‘Data’ tab in the top menu of the excel workbook 
3. Click on the ‘AZ’ button 

 

 

Step 5- Adding a line break when the Card Data changes 
1. Click in the first cell ‘SYS_Date’ 
2. Click on the ‘Subtotal’ button 
3. In the ‘At each change in:’ drop down menu, change from SYS_Date to CARD_DATA 
4. In the ‘Use Function:’ drop down menu, change from Sum to ‘COUNT’ 
5. In the ‘Add subtotal to:’ box, untick any boxes that are ticked 
6. Scroll up and tick the box next to “PROVIDER_NUMBER” (this should be the only box ticked) 
7. Click ‘OK’ 

 
 

8. Look to see if the same card was only used by one provider and the other card was used at 
several other providers. 
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Monitoring card use across postcode 

Background 
Funds have uncovered in the past, practices that retain membership cards to swipe claims when the 
member is not present. This can be important for funds that do not allow backdating of claims. On 
family policies, one card can be left with the provider while the family utilises the other card for 
other legitimate transactions. This process will help identify which card is being used at what 
provider. 

Use to identify 
• Providers that are possibly retaining membership cards 
• Family memberships possibly leaving one card with a provider and using the other to claim 

all other claims 

Procedure 

Step 1- extracting data from HICAPS Online 
1. Navigate to the HICAPS website (www.hicaps.com.au) and login to “Accounts Online” 

2. Hover your mouse cursor over the ‘Funds’ tab on the top left hand side of the page. A box 
will now appear as shown below. 

 
 
 
 
 
 
 
 
 

 

3. In the box that has now appeared, select the “View Transaction Search” (see above) 

4. On the search screen: 

http://www.hicaps.com.au/�
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a. Change the ‘Report Output Format’ to “CSV Download”  
b. Change the start and end dates to reflect the period you want the data extracted   

(Note: If the query is taking too long, please try a shorter time period) 
c. Put the postcode in the white box below the ‘Postcode’ field 
d. Ensure that the “Display Results” have the following options selected (preferably in 

this order): 
i. Sys Date 

ii. Sys Time 
iii. Member # 
iv. Provider # 
v. Card Data 

vi. Terminal # 
e. Click ‘search’ 

 
 

5. The ‘File Download’ box will appear (pictured below). Click on ‘save’ 
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IMPORTANT:  You must save this file rather than opening it. Excel will alter the card number if you 
do not follow the process below. 

Step 2- Opening the file in Excel 
1. Open Excel 
2. Click on the ‘Data’ tab in the top menu of the excel workbook 
3. Click on the ‘From Text’ button 

 

4. Navigate to the location that you saved the file and select it 
5. Click ‘Import’ 

 

6. A new window will now appear. Ensure the button next to ‘Delimited’ is selected 
 

7. Click ‘Next >’ 
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8. On the new window in the ‘Delimiter’ section tick “Comma” [if any other boxes are ticked, 
untick them- there should only be one box ticked] 
 

9. Click ‘Next >’ 

 

10. Click with the mouse cursor in the ‘Card_Data’ field- the background will now change from 
white to black 
 

11. In the “Column data format” section, select ‘Text’ 
 

12. Click ‘Finish’ 
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13. A new window will now appear- Click ‘OK’ 

 

Step 3- Save the workbook 
1. Click ‘Save’ and save the file in your desired location 

 

Step 4- Sorting transactions by Card Data 
1. Click on the words “CARD_DATA” [in the example this will be in cell E1] 
2. Click on the ‘Data’ tab in the top menu of the excel workbook 
3. Click on the ‘AZ’ button 

 

 

Step 5- Adding a line break when the Card Data changes 
1. Click in the first cell ‘SYS_Date’ 
2. Click on the ‘Subtotal’ button 
3. In the ‘At each change in:’ drop down menu, change from SYS_Date to CARD_DATA 
4. In the ‘Use Function:’ drop down menu, change from Sum to ‘COUNT’ 
5. In the ‘Add subtotal to:’ box, untick any boxes that are ticked 
6. Scroll up and tick the box next to “PROVIDER_NUMBER” (this should be the only box ticked) 
7. Click ‘OK’ 
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8. Look to see if the same card was used by multiple provider numbers across the period. 
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Chair-side hours 

Background 
Certain modalities under the HICAPS network have time based items. By extracting the data, you can 
identify the items used and accord the equivalent time required for the item. A summing of these 
times will give you the ‘chair-side’ hours for your fund for that provider over the given day/s. 

Use to identify 
• Up-coding 
• Padding of claims 
• Adding additional patients not present 

Procedure 

Step 1- extracting data from HICAPS Online 
1. Navigate to the HICAPS website (www.hicaps.com.au) and login to “Accounts Online” 

2. Hover your mouse cursor over the ‘Funds’ tab on the top left hand side of the page. A box 
will now appear as shown below. 

 
 
 
 
 
 
 
 
 

 

3. In the box that has now appeared, select the “View Transaction Item Search” (see above) 

4. On the search screen: 
a. Change the ‘Report Output Format’ to “CSV Download”  

http://www.hicaps.com.au/�
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b. Put the provider number in the white box below the ‘Provider #’ field 
c. Enter the date you wish to report on in the ‘Sys Date’ field 
d. Ensure that the “Display Results” have the following options selected (preferably in 

this order): 
i. Sys Date 

ii. Item Number 
iii. Itm Date 
iv. Member # 
v. Patient Index 

e. Click ‘search’ 

  
 

Tip: You can add additional dates by selecting more occurrences of ‘Sys Date’ in the search 
criteria section of the window (see ‘X’ above) and putting a date in the field beneath each 
(one date per box). The system will extract data for each of the dates that you enter. 
 

5. The ‘File Download’ box will appear (pictured below). Click on ‘open’ 
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Step 2- Changing file type from CSV to Excel workbook 
1. The file will now open in Excel. Currently it is in the format of ‘csv’, we need to change to an 

excel format. To do this: 

a. Click on the round circle in the top left hand corner 
b. Hover your mouse cursor over ‘Save As’ It is important you DO NOT
c. A box will now appear- click on “Excel Workbook” at the top of the list 

 click on it 

 

 
 

Step 3- Sorting transactions into chronological order 
1. Click on the ‘Data’ tab in the top menu of the excel workbook 
2. Click on the ‘Sort’ button 

 
 

3. To order the file correctly we need to sort by the date then by time. To do this: 
a. Click on the ‘Add Level’ button- this will add an extra line into the white box 
b. In the first drop down box select ‘SYS_Date’ 
c. In the second drop down box select ‘Item_Number’ 
d. Click ‘OK’ 
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Step 4- Resize the cells to fit the content 
1. Click on the corner between the letter ‘A’ and number ‘1’ as shown below- This will highlight 

all of the workbook 
2. Double click on the white line between ‘A’ and ‘B’ 

 

 

Step 5- Creating a pivot table 
1. Click on the ‘Insert’ tab in the top menu of the excel workbook 
2. Click on the ‘Pivot Table’ button 

 

3. A new window will now appear- Click OK 
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4. A new sheet will now be added to your workbook. 
 

5. On the right hand side of the screen will be the Pivot Table Field List (see below) 

 

6. Drag and drop: 
a. “Sys_Date” into the Row Labels box 
b. “ITEM_Number” into the Column Labels box 
c. “ITEM_Number” into the Values box 

 
7. A table will now be created containing the information 
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Appendix A- Item Response Codes 

Code Description Receipt Print Out 

00 - Approved Approved 

01 - Nil benefit payable on this item Item No Benefit 

02 - Nil benefit - restricted item Restricted Item 

03 - Reduced benefit - restricted item Restricted Item 

04 - Nil benefit - benefit previously paid Previously Paid 

05 - Nil benefit - limit reached Limit Reached 

06 - Reduced benefit - limit reached Limit Reached 

07 - Nil benefit - qualifying period applies Waiting Period 

08 - Nil benefit - pre-requisite service required PreReq Ser Reqd 

09 - Nil benefit - pre existing ailment Pre Existing 

10 - Item number invalid Item Nbr Invalid 

11 - Item number ceased Item Nbr Ceased 

12 - Item not valid for provider Item Not Valid 

13 - Item not approved …not payable by HICAPS Item Not Apprvd 

14 - Service exceeds number of times permitted Max Nbr Ser Exc 

15 - Cost must be entered Cost Missing 

16 - Date of service must be before today DOS Not Valid 

17 - Date of service too old DOS too Old 

18 - Clinical Code required Clincl Code Rqd 

19 - Patient not covered Pat Not Covered 

20 - Dependent status ceased Depd Status End 

21 - Invalid patient code Invald Pat Code 

22 - Membership not covered Mship Not Cover 

23 - Membership ceased/suspended at DOS Mship Ended DOS 

24 - Membership unfinancial Mship Unfin DOS 

25 - No ancillary cover No Ancill Cover 

26 - Not covered for this service Item Not Coverd 

27 - Duplicate service already processed  Duplicate Serv 

28 - Nil benefit – Excess on services applied Excess on Serv 

29 - Reduced benefit – Excess on services applied Excess on Serv 

30 - Nil benefit – Quote required prior to service Quote Required 

31 - Reduced benefit – Quote required prior to service Quote Required 

32 - Nil benefit – Claim exceeds quotation Exceeds Quote 
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Code Description Receipt Print Out 

33 - Reduced benefit – Claim exceeds quotation Exceeds Quote 

34 - Nil benefit – Age restriction applies Age Restriction 

35 - Reduced benefit – Age restriction applies Age Restriction 

36 - Nil benefit – Gender restriction applies Gender Restrict 

37 - Reduced benefit – Gender restriction applies Gender Restrict 

38 - Nil benefit – Amount charged is invalid Invalid Charge 

39 - Notional Charge Notional Charge 

40 - Converted Item Converted Item 

41 - Refer to Health Fund Refer to Fund 

42 - System Problem System Problem 

43 - Transaction Declined – Refer Tran Resp Code Tran Declined 

50 - Provider not approved by Fund (at DOS) Prov Not Approv 

51 - Provider not approved by Fund for this service at 
DOS Prov Not Approv 

52 - Tooth ID Number Required Tooth Id Reqd 

53 - Service Date Before Injury Date DOS before Injury 

54 - Transaction Submitted for Processing Submitted 

P0-PZ Refer to Health Fund Refer to Fund 
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Appendix B- Transaction Response Codes 
Code Description Receipt Print Out 

00 - Approved or completed successfully Approved (8) 

01 - Provider not approved by fund Prov Not Approv (15) 

02 - Membership under investigation Mship Under Invest (19) 

03 - Invalid provider number Invalid Prov Nbr (16) 

04 - Retain card Retain Card (11) 

05 - Transaction Timeout (Terminal reports as 91) System Inoperative (17) 

06 - Transaction Timeout (Subsequently identified)  

09 - Transaction submitted for processing Submitted 

12 - Declined Declined (8) 

14 - Invalid card number (no such number) Invalid Card Nbr (16) 

19 - No items entered No Items Entered (16) 

21 - No action taken Call Help Desk(14)1 

32 - System generated Reversal   

40 - Membership not covered Mship Not Covered (18) 

42 - Membership ceased/suspended at date of service Mship Ended at DOS (19) 

51 - Membership unfinancial Mship Unfinancial (17) 

54 - Expired card Expired Card (12) 

56 - Invalid membership number Invalid Mship Nbr (18) 

57 - No ancillary cover No Ancillary Cover (19) 

58 - Transaction not permitted to terminal Txn Not Permitted (17) 

60 - Provider not registered with fund Provider Not Registd (16) 

61 - Benefit limit exceeded Benefit Limit Exced (19) 

68 - System generated Reversal   

80 - Payment should be made by the Claimant's 
Employer Refer Employer (14) 

81 - Unable to Match Cancel to Previous Claim Unmatched Cancel (16) 

82 - Claim being Cancelled has already been Settled Unsupported Cancel (18) 

91 - Health Fund Down Fund Down (10) 

94 - Duplicate transmission Duplicate Txn (13) 

97 - Advises that reconciliation totals have been reset Reconc Totals Reset (19) 

QL - Quote Limit Reached Quote Limit Reached 

QN - Quote Not Available  Quote Not Available 

P0-PZ Refer to Health Fund Refer Health Fund (17)2 
 

 



 

 

 

 

 

 

 

 

 

 

If you would like further assistance with 
the content of this document, 

please contact 
 

Luke Givney 
Provider and Claims Compliance 
The Hospitals Contribution Fund of Australia 
GPO Box 4242, Sydney NSW 2001 
Ph: 02 9290 0284 
Mob: 0421 835 140 
Email: lgivney@hcf.com.au  
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